Getting Started

Using BarTender Label Software, Commander Integration Utility, and Seagull Printer Drivers

(English Edition)
Getting Started

Using BarTender Label Software, Commander Integration Utility, and Seagull Printer Drivers

(English Edition)
# Table of Contents

## Chapter 1: Installation and Activation

1. BarTender Components ....................................................................................................................... 1

### Installation Procedures

- Installing the Security Key (Keyed Licenses Only) ................................................................................. 2
- Installing Seagull License Server (Enterprise Editions Only) ................................................................. 3
- Installing BarTender .................................................................................................................................. 4
- Installing Commander .............................................................................................................................. 4
- Installing BarTender Web Print Server ................................................................................................... 4

2. Activation .................................................................................................................................................. 4

## Chapter 2: Using BarTender

1. Overview .................................................................................................................................................. 5

- Creating a New Label Format .................................................................................................................. 6
- Specifying the Correct Printer .................................................................................................................. 6
- Specifying the Label Size .......................................................................................................................... 6
- Creating a Text Object .............................................................................................................................. 8
- Creating a Bar Code or RFID Object ........................................................................................................ 8
- Selecting and Deselecting an Object ........................................................................................................ 8
- Moving a Label Object ............................................................................................................................. 9
- Stretching and Resizing Objects ............................................................................................................... 9
- Copying, Cutting, and Pasting a Label Object ........................................................................................... 9
- Deleting an Object from the Label Viewing Area ...................................................................................... 10
- Specifying the Data Source of a Text or Bar Code Object ..................................................................... 10
- Setting Up a Connection to a Database .................................................................................................... 12
- Changing the Symbology of a Bar Code ................................................................................................... 13
- Changing the Font ..................................................................................................................................... 13
- Other Modifications to the Properties of Label Objects .......................................................................... 13
- Importing a Picture .................................................................................................................................... 13
- Printing the Label ..................................................................................................................................... 14
- Starting with a Preexisting BarTender Format ......................................................................................... 14
- The BarTender Toolbox ........................................................................................................................... 15

2. Getting BarTender Help ......................................................................................................................... 15
Seagull License Server ........................................................................................................ 16

Chapter 3: Commander, Enterprise Integration Utility .......... 17
What Is Commander? ........................................................................................................... 17
Common Procedures for Commander ................................................................................. 18
Launching Commander ...................................................................................................... 18
Creating or Modifying a Commander Task List ............................................................... 18
Deleting, Moving, and Reordering Commander Tasks ...................................................... 18
Running a Commander Task List ........................................................................................ 19
For More Information ........................................................................................................ 19

Chapter 4: BarTender Web Print Server ............................................................ 21
What Is BarTender Web Print Server? ............................................................................... 21
Using BarTender Web Print Server ................................................................................... 21
Label Format Selection ....................................................................................................... 21
Printing ................................................................................................................................ 21
Site Administration ............................................................................................................. 22
For More Information ........................................................................................................ 22

Chapter 5: Installing and Configuring Seagull Printer Drivers .... 23
Overview ............................................................................................................................. 23
Installing, Upgrading and Removing Printer Drivers ......................................................... 23
Driver Installation Instructions ............................................................................................ 23
Upgrading Printer Drivers ................................................................................................... 24
Removing Printer Drivers .................................................................................................... 24
Serial Communications ...................................................................................................... 24
Configuring for Performance .............................................................................................. 28
Performance Tips ............................................................................................................... 28
Printer Capabilities That Are Not Available To All Programs .......................................... 29

Appendix A: Printer Driver Troubleshooting ......................................................... 31
Step-by-Step Procedure for Solving Printing Problems ...................................................... 31

Appendix B: Technical Support ................................................................................. 35

Index ................................................................................................................................. 37
Chapter 1: Installation and Activation

BarTender Components

There are a number of components that you may need to install.

♦ **BarTender**: A powerful program for designing and printing bar code labels and other labels that can read data from multiple sources. It can also encode RFID tags (RFID Enterprise Edition only).

♦ **Commander (Enterprise editions only)**: A program that automatically performs user-defined tasks in response to a trigger. Refer to Common Procedures for Commander below.

♦ **Seagull License Server (Enterprise editions only)**: A software tool for monitoring and enforcing printer licenses. Refer to Seagull License Server below.

♦ **BarTender Web Print Server (Enterprise Print Server edition only)**: A web application to support label printing from browsers. Refer to Activation below.

♦ **BarTender Security Key (keyed licenses only)**: A hardware security key that attaches to a parallel or USB port.

♦ **Seagull Printer Drivers for Popular High Speed Label and RFID Printers**: Refer to Chapter 3.

In addition to installing components, you will also activate your software. (See Activation below.)
Installation Procedures

The BarTender components must be installed in the order that they are listed below. Which components you need to install will depend on your operating system and BarTender edition. The BarTender CD-ROM will automatically display an opening screen from which you can install all of the software components.

Installing the Security Key (Keyed Licenses Only)

If your edition of BarTender comes with a HASP® security key, it must be installed on either a parallel or USB port of the computer. (With the Enterprise Editions, the key goes on the computer that will run Seagull License Server. See Installing Seagull License Server below.) Without this security device installed, BarTender will operate only in demonstration mode: one letter or number from each text field and bar code will be randomly changed when labels are printed.

Installing the HASP4 Security Key Driver

1. Place the BarTender CD-ROM into your CD drive. The opening screen will appear automatically.
2. Click BarTender Label Printing Software on the opening screen. Then click HASP4 Security Key Driver and follow the instructions given by the setup program.
3. Continue with the appropriate instructions, below, depending on your key type:

Parallel Port Key Installation

1. Plug the key into a parallel port on your computer, preferably LPT1.
2. Attach the security keys from other vendors, if any, to the back of the Seagull Scientific key.
3. Plug the cable, if any, directly into the key itself.
Chapter 1: Installation and Activation

**USB Port Key Installation**

Plug the key into an available USB port.

**Installing Seagull License Server (Enterprise Editions Only)**

If you have one of the Enterprise Editions of BarTender, install the Seagull License Server before installing BarTender. This application runs unattended and invisibly on any computer on your network. You may install it on a computer that will also run BarTender. Seagull License Server interacts with BarTender seamlessly so that BarTender users need not even know that it is running.

1. Choose a computer on your network to be the host of the Seagull License Server. It can be any computer, so long as it is accessible through your network from the workstations on which you run BarTender. To operate BarTender on machines separated from the license server by a router, contact Seagull Scientific Technical Support. (Refer to Appendix B: Technical Support.)

2. If you are not already viewing the opening screen, place the BarTender CD-ROM into your CD drive. The opening screen will appear automatically.

3. Click **BarTender Label Printing Software** on the opening screen. Then click **Seagull License Server**.

4. You will be given the opportunity to run the **Activation Wizard** near the end of the installation. If you run it, follow the instructions on screen. (See **Activation** below.)

For detailed help about Seagull License Server and how it works with BarTender:

1. On the Seagull License Server menu, click **Help** and select **Seagull License Server Help**.

2. On the BarTender menu, click **Tools** and select **General Options**. Open the **License Management** tab and click the **Help** button.
Installing BarTender

Perform these steps on every computer on which you plan to run BarTender.

1. If you are not already viewing the opening screen, place the BarTender CD-ROM into your CD drive. The opening screen will appear automatically.
2. Click BarTender Label Printing Software on the opening screen. Then click BarTender and follow the instructions given by the setup program.

Installing Commander

With the Enterprise editions, Commander is automatically installed with BarTender. No additional installation steps are required.

Installing BarTender Web Print Server

This application is only available with the Enterprise Print Server edition. To install this option:

1. If you are not already viewing the opening dialog of the install program, place the BarTender CD-ROM into your CD drive. The opening dialog will appear automatically.
2. Click BarTender Label Printing Software.
3. Click BarTender Web Print Server and follow the instructions.

Activation

During the installation, you will have the opportunity to activate your software. Activation is a quick, easy, anonymous process that unlocks a software product for unlimited use and helps combat software piracy. When you choose to activate, an Activation Wizard will run. Click its Help button for more information about activation and privacy.
Chapter 2: Using BarTender

Overview

This chapter guides you through the process of designing labels, modifying their formats, and specifying the data you want to print. Begin by running BarTender. A blank label is displayed and your on-screen mouse cursor should be in pointer mode (shaped like an arrow).
Creating a New Label Format

To begin a new label format:

2. The New Label Format Wizard guides you through the steps needed to start your format design.

If you prefer not to use the wizard, follow the instructions in the next two sections.

Specifying the Correct Printer

The first step in designing any label format is to specify the printer that will most often be used to print the labels made from the format. This reduces the chance that the labels will contain fonts that the printer cannot print quickly, and the chance that the size of the label format will exceed the printer's memory.

1. Click the printer button on the Main toolbar, or Print in the File menu, to display the Print dialog.
2. Click the down arrow on the right side of the Name option to display a list of installed printer drivers.
3. Click the name of the printer to which you will be printing.

Note:
If the desired printer is not listed, use the Seagull Driver Wizard to install its printer driver. Refer to Installing and Configuring Seagull Printer Drivers below.

4. Click Close.

Specifying the Label Size

1. Display the Page Setup dialog by either clicking the page setup button on the Main toolbar, clicking Page Setup in the File menu, or double-clicking on the blank part of the label viewing area.
2. Click the Stock tab and select the label stock manufacturer from the Category list. (If your label stock manufacturer is not listed, skip to step 4.)
3. Select the stock from the **Stock Name** list. (If your stock is not listed, proceed with step 4, otherwise click **OK**.)

4. Click the **Pager** tab and specify the **Pager Size** and the **Orientation** (either **Portrait** or **Landscape**).

5. Click the **Layout** tab and specify the page margins, and the number of rows and columns. (These options are usually available for laser printers only, but occasionally label stock for thermal printers may have columns and/or rows.)

6. To specify the dimensions of the labels, check the **Set Manually** box and use the **Height (of Label)** and **Width (of Label)** boxes. (BarTender will set the height and width of your label automatically if the **Set Manually** box is not checked.)

7. Click **OK**.
Creating a Text Object

1. Click the create text button \( T \) on the Main toolbar.
2. Move the cursor into the label viewing area and click where the center of the object should be located.

Note:
You can also use the BarTender Toolbox to add objects to a label. Refer to The BarTender Toolbox below.

Creating a Bar Code or RFID Object

1. Open the Standard Bar Code or Standard RFID pane in the Toolbox. (Refer to The BarTender Toolbox below.) Each has a list of already configured objects. The bar codes have a symbology and other options already chosen. The RFID objects are configured with a tag type and a data format scheme.
2. Drag the desired object to the label.

Notes:
If you prefer a bar code or RFID object with default values in all its properties, you can click the bar code button \( \text{[ ]} \) or RFID button \( \text{[ ]} \) on the Main toolbar and then click on the label.
You must have the RFID Enterprise Edition to add RFID objects to a label.

Selecting and Deselecting an Object

To select any object, click it. When an object is selected, it has eight solid handles, one at each corner and one in the middle of each of the four sides, used for resizing the object. Click anywhere away from an object to deselect it.
Moving a Label Object

The easiest way to change the position of an object in the label viewing area is to click and drag it to a new location using your mouse.

Refer to Copying, Cutting, and Pasting a Label Object below for how to move an object from one label format to another.

Stretching and Resizing Objects

A label object is resized by clicking it once (to select it) and then dragging one of the small square handles that appear along the edges of the object.

1. Select the object and position the pointer cursor on one of the four corner handles to resize both height and width. To resize in only one direction, position the pointer on one of the side handles. When the cursor is properly positioned, it will turn into a thin arrow with points at both ends.
2. Click and drag the selected handle until the object is the desired size.

Copying, Cutting, and Pasting a Label Object

Using The Windows Clipboard

Any bar code or text object can be copied (or cut) and pasted to another label format, or to another place on the current label format, using the Windows clipboard, and the Copy, Cut, and Paste buttons. See your Windows documentation for details.

Using Click and Drag

You can also click and drag an object to a new place on a label format. Doing this with the CONTROL key held down creates a copy at the new location.

Finally, you can right-click and drag to the desired location. Release the mouse button and a pop-up menu appears. Click Copy Here on the menu.
Deleting an Object from the Label Viewing Area

Select the object and press the DELETE key or click Delete on the Edit menu. (To remove an object from the label viewing area, but save a copy of its specifications in the Windows clipboard at the same time, use the Cut command instead of the Delete command.)

Specifying the Data Source of a Text or Bar Code Object

Label data often must come from a variety of sources. Label formats made in BarTender can contain:

Data from databases, including delimited text files, fixed-width text files, OLE DB, ODBC (Open Database Connectivity) databases and spreadsheets, and SAP™ IDocs

Data generated from Visual Basic Scripts

The system date and time on your computer

Data entered directly onto a label at the screen

To set a label object’s data source:

1. Double-click on the label object whose label data you want to change. The Modify Selected... Object tabbed dialogs will be displayed.
2. If it is not already displayed, click on the Data Source tab to display the Data Source property page.
3. To be guided through the process of selecting a data source, click the data wizard button to launch the Substring Wizard. Alternatively, continue with the following steps.
4. Select the desired data source from the Source drop down list, and then configure the source-specific parameters in the Options section of the tab. If you are selecting Database Field as the source and have not yet setup a connection to a database, then press the database connection setup button. See Setting Up a Connection to a Database below.
To concatenate substrings from multiple data sources:

Sometimes you need to place information from two or more data sources into a single bar code or text object. You can do this by concatenating multiple data substrings so that they are output as a single string. Follow these steps:

1. On the Data Source tab of the Modify Selected . . . Object dialog, click the Advanced button.

2. Create additional substrings by clicking the new substring button on the toolbar below the Substring List.

Refer to BarTender’s help for additional data-sourcing topics such as data validation, serialization, and prompting.
Setting Up a Connection to a Database

Sometimes it is desirable to print labels from a list of data, such as a parts list or a list of customers. This requires reading label data from a database. BarTender can read from the following database types:

♦ Delimited and Fixed-Width Text Files
♦ Oracle®, Microsoft Access, Excel, and SQL Server™
♦ Other OLE DB Supported Databases
♦ ODBC (Open Database Connectivity) Supported Databases and Spreadsheets
♦ SAP IDocs

To tell BarTender to read from a database:

1. Open the Database Connection Setup dialog by clicking on the database connection setup button on the Main BarTender toolbar. The Add Database Connection Wizard will display in the center of the dialog.
2. The **Add Database Connection Wizard** guides you through the steps needed to configure a connection to your database.

Refer to BarTender’s help for information about joining tables, reading from multiple databases, and specifying queries.

### Changing the Symbology of a Bar Code

1. Double-click the bar code to display the **Modify Selected Bar Code Object** dialog.
2. Click the **Bar Code** tab.
3. Display the list of available bar code symbologies by clicking the down-arrow on the right of the **Symbology** box.
4. Click the name of the desired symbology.
5. Click **OK**.

### Changing the Font

1. Double-click the bar code or text object. The **Modify Selected . . . Object** dialog is displayed.
2. Click the **Font** tab.
3. Change the typeface name, size, italics, boldness, scale, and script as needed.
4. Click **OK**

### Other Modifications to the Properties of Label Objects

Double-clicking any object displays the **Modify Selected . . .** dialog for that type of object. Click a tab to open the corresponding property page.

### Importing a Picture

This procedure should be used when the picture will not be changing from label to label.
1. Click the create picture button on the Main toolbar.
2. Click where you want the picture located. A sample picture appears on the label format.
3. Double-click the picture to display the Modify Selected Picture dialog.
4. Leave the Type option set to Embedded Picture, but click the Select Picture button to display the Select Picture dialog.
5. The Select Picture dialog is a standard Windows directory navigation dialog. Use it to locate and double-click the picture file you want to import. BarTender automatically returns you to the Modify Selected Picture dialog.
6. Click OK.

After you have placed the picture in the label viewing area, you may change its position as explained in Moving a Label Object above.

Printing the Label

1. Click the printer button on the Main toolbar, or the Print option in the File menu, to display the Print dialog.
2. Confirm that the correct printer name is selected.
3. If any of the objects in your label format use data from a database file, the Use Database box should be checked. You can use the database connection setup button to display the Database Connection Setup dialog.
4. Type the number of copies desired of each label into the Identical Copies of Label option.
5. Click the Print button and BarTender will begin printing your labels.

Starting with a Preexisting BarTender Format

BarTender comes with some predesigned label formats. If one of them is close to your needs, it may be faster for you to modify it rather than design a complete label format.
To view the predesigned label formats:

1. Select **File**.
2. Select **Open**.
3. In the **Format File Open** dialog, for Windows 2000, 2003 and XP navigate to *My Documents*\*BarTender*\*Formats*\*Samples*. In Windows Vista navigate to *Documents*\*BarTender*\*Formats*\*Samples*.
4. Single-click any label format name. A preview of the label format will appear in the dialog’s **Preview** window.

If you find a label format close to what you need, double-click the name to display it in BarTender. Make any desired modifications and then save your changes to a new label format by using **Save As** instead of **Save**.

**The BarTender Toolbox**

The BarTender Toolbox provides additional functions and alternative ways of accomplishing certain tasks. It contains four panes:

- **Components**: This functions as a storage bin in which you save bar codes, text, and other objects, or groups of objects, that you have configured. Reuse any stored component by dragging it onto a label.
- **Data Sources**: Use this pane to link objects quickly to particular data sources including previously configured database fields or substrings.
- **Standard Bar Codes**: From this pane you can drag bar codes that are already linked to particular symbologies.
- **Standard RFID**: From this pane you can drag RFID objects that are already configured with a data format type.

**Getting BarTender Help**

You can access the help system by using any of the following procedures.
To open the main help window:

Click BarTender Help menu option in the Help menu.

To access context-sensitive help:

♦ From inside of a dialog, click the Help button or press F1.

or

♦ For help on a particular menu option, highlight the menu option and press F1.

For further options in using and customizing the help, see the topic Using BarTender's Online Help in the help system.

For help with Visual Basic select Visual Basic Script Help from the Help menu. This will open Microsoft’s full Visual Basic help document in your default web browser.

Seagull License Server

Note:

This section applies only to the Enterprise Editions of BarTender.

The Seagull License Server is a tool for monitoring and enforcing printer licenses. It runs, unattended, on any computer on the LAN and will monitor BarTender clients over a LAN. Each time BarTender starts a print job, Seagull License Server keeps track of the total number of printers being used.

Seagull License Server can be configured to operate as a Windows service that runs whenever your computer is on, whether or not anyone is actually logged into the computer.

Refer to the Installing Seagull License Server section above for installation instructions. Refer to Seagull License Server's help for further details about its operation.
Chapter 3: Commander, Enterprise Integration Utility

What Is Commander?

Commander is a software utility, available with the Enterprise editions of BarTender, that enables you to perform automatic label-printing using BarTender in situations where using command line or ActiveX automation is either not possible or not cost-effective. Commander can be run as an application or as a Windows service.

When an application needs labels, it simply creates a triggering event (called a “trigger”), such as placing a file in a location of your choosing on the network or sending an e-mail to an account of your choosing. Commander detects the arrival of this file (or e-mail) and then “wakes up” BarTender so it can flow your data into the label design and automatically print your labels.

A trigger file or message may be empty; but it can also contain data that will be read by BarTender, by another application that Commander launches, or by Commander itself. Because trigger-creating applications can include different content in different triggers, the tasks Commander will execute, and the data it uses, can be defined dynamically by the application.

For example, an in-house order fulfillment application enters data about an order into a database and saves an empty file named NewOrder.dat in a directory being watched by Commander. Commander finds the file and launches BarTender with a label format that has been configured to query the database about orders entered after a specified time. BarTender reads the data and prints the label. Commander then deletes the NewOrder.dat file and resumes monitoring the directory.
Common Procedures for Commander

Launching Commander

To launch Commander, double-click its icon on the Seagull branch of the Start menu. Below are the steps for the most common tasks.

Creating or Modifying a Commander Task List

Commander actions are governed by tasks lists, which identify the triggers and the tasks to be performed in response. To create a task list:

1. Create a new task list file by clicking the new task list button or selecting New from the File menu. If you are modifying an existing task list, click the open button or select Open from the File menu; then browse to the task list file and click Open.
2. Start a new task definition by clicking the create new task toolbar button or selecting Add from the Tasks menu. If you are editing an existing task, highlight it and click the properties toolbar button or select Properties from the Task menu.
3. Use the Task Options dialog to enter details about how to trigger the task and to select and configure the commands that will execute when the task is triggered, then click OK.
4. Repeat steps 2 and 3 for every task needed on the task list, and then save the task list.

Deleting, Moving, and Reordering Commander Tasks

Delete tasks from the list by highlighting the task and pressing the DELETE button or selecting Delete from the Edit menu. Use the Cut, Copy, and Paste items on the Edit menu to reorder tasks as needed or to move tasks from one task list to another.
Running a Commander Task List

To run a Commander task list:

1. Open a task list by clicking the open button or selecting Open from the File menu.
2. Enable tasks by highlighting each task you want to execute and selecting Enable from the Task menu.
3. Start trigger detection by clicking the start detection button or selecting Start Detection from the Detection menu.

For More Information

There are a number of sources of additional information on Commander.

Commander Help

Commander comes with an extensive help system that includes detailed examples of Commander in use and additional information about its many powerful features.

White Papers

These two white papers provide more details about using Commander:

♦ Commander
♦ Commander Examples

You can view these and other white papers at:

Chapter 4: BarTender Web Print Server

What Is BarTender Web Print Server?

BarTender Web Print Server is an ASP.Net application that comes with the Enterprise Print Server edition of BarTender. It lets you use any web browser to select BarTender labels and then output them on a printer anywhere on your LAN, WAN, or even to remote printers on the internet. There is also a PDF printing option.

Using BarTender Web Print Server

There are three primary pages in the BarTender Web Print Server application, one each for:

♦ Label format selection
♦ Label printing
♦ Site administration

Label Format Selection

The home page of BarTender Web Print Server shows previews of all of your available label formats. When you have a large number of label formats, you can limit or “filter” the number of previews that are displayed by entering the first few characters of the desired formats into the Search function.

Printing

Once you click on a label format to select it, the Print page is displayed. This is where you select the desired printer, specify the print quantity, and
print labels. Additionally, other controls will be available based on the design of your label format.

**Data Prompt Dialogs**

BarTender has for years supported the design of query and data entry dialogs that ask users for data at print time. When you use the BarTender Web Print Server to print label formats that use either of these prompting features, the contents of the prompt dialogs are automatically converted into HTML and displayed on the Print page. For more details:

- In the BarTender Help system, search on “Query Prompts” and “Prompt at Print Time.”
- Read the “BarTender Web Print Server” White Paper.

**Site Administration**

The Site Administration page is used to configure the Web Print Server application, including which functions will be visible on the Label Format Selection and Printing pages. It is intended for use by system administrators only and is therefore not accessible by normal print-time users. To access Site Administration, you must use the Windows Start menu on the web server.

**For More Information**

You can find the BarTender Web Print Server white paper at:

Chapter 5: Installing and Configuring Seagull Printer Drivers

Overview

This chapter tells you how to install Windows “Drivers by Seagull™” for thermal label printers, as well as how to upgrade and remove printer drivers. It also explains how to maximize printing performance and contains information about improving communication through a serial port.

Installing, Upgrading and Removing Printer Drivers

Starting with Bartender 8.0, Drivers by Seagull™ began shipping with the Seagull Driver Wizard utility.

A Warning About Microsoft’s “Add Printer Wizard:”

We strongly recommend that you use Seagull’s Driver Wizard to install, remove, and upgrade drivers. The “Add Printer Wizard” that comes with Windows does not always properly perform driver upgrades.

Driver Installation Instructions

1. Turn off your printer, connect the appropriate cable, and then turn on the printer.
2. If your printer supports Plug-and-Play and you have connected it using a USB or Parallel cable, then the Windows Add Hardware Wizard will automatically detect the printer and display a driver install dialog. Be sure to click Cancel and not install the driver using this Windows wizard.
3. Instead, run the Driver Wizard utility from the folder where the Seagull printer driver files are located.
4. Select **Install Printer Drivers** and complete the wizard.
5. Your Seagull driver(s) should now be properly installed.

**Upgrading Printer Drivers**

Do *not* use the Microsoft Windows Add Printer Wizard to upgrade printer drivers. It sometimes does not upgrade all driver files correctly, which leaves printer drivers in a corrupted state.

Instead, use Seagull’s Driver Wizard to upgrade existing printer drivers:

1. Run the Driver Wizard utility from the folder where the driver files are located.
2. Select **Upgrade Printer Drivers** and complete the wizard.

**Removing Printer Drivers**

Driver Wizard may be used to remove printer drivers from the system.

1. Run the Driver Wizard utility from the folder where the driver files are located.
2. Select **Remove Printer Drivers** and complete the wizard.

**Serial Communications**

**Overview**

We recommend that you use a parallel port, USB port, or Ethernet connection if any of these is available on your printer. They improve printer performance and they eliminate confusion about what kind of cable to use.

However, some printers come with only a 9-pin or 25-pin (RS-232) serial port. This section covers some of the most common obstacles encountered with such old-style serial port communications and explains how to best configure Windows and select the proper serial cable.
Note:

A more detailed discussion of serial communication issues is in the Serial Communications section of your printer driver’s help.

Setting and Cable Issues

If you don't set the serial ports on your computer and printer identically, communication will be unreliable. Moreover, there are dozens of ways that serial cables can be wired internally and one can't tell by looking at a serial cable how it is wired.

It is important to keep in mind that the program from which you will be printing, such as BarTender, does not control the serial communication between your computer and printer. Your mode of serial communications is controlled by:

♦ The serial port settings in your printer.
♦ The serial port settings on your computer.
♦ The type of serial cable being used.

Serial Port Settings

Serial communication is governed by the following parameters. These must be set identically on both the printer and the computer.

♦ Baud Rate: This is the rate at which your printer will receive data (in bits-per-second). Common values are 2400, 4800, 9600, 19200, 38400, and 57600; with 9600 being the most common default setting. You want to set the highest rate at which your printer will work reliably. Use trial-and-error to find this rate after you have set your other serial communication parameters.

♦ Data Bits (sometimes called "Word" length or byte length): This specifies the number of bits used to encode each character sent to your printer. The most common value is 8, although older printers may default to 7.
♦ **Parity Bit**: This is an optional extra bit sometimes sent after the data bits of a transmitted character for the purpose of error checking. The possible settings are **Odd**, **Even**, and **None**.

♦ **Stop Bits**: This is the length of the pause at the end of a transmitted character. One stop bit is the most common setting.

♦ **Flow Control** (sometimes called "Handshaking"): This can be set to **software** (also called **Xon/Xoff**) or **hardware**. Never use the **None** setting for Flow Control. Disabling flow control can result in intermittently corrupted or completely failed print jobs.

**Note:**

Refer to the topic *Understanding and Setting Flow Control (Handshaking)* in your printer driver's help for more information about choosing a handshaking method.

### Setting Serial Parameters on your Printer

You control serial port settings for your printer with either DIP switch settings or through a menu system accessed from the printer's front panel. Consult your printer's documentation for details.

Most printers do not allow changing all of the above parameters. Consult your printer manual to determine what settings are required, and be sure to make identical settings in Windows.

### Setting Serial Parameters in Windows

You first specified your serial port settings when you installed your printer driver, but if you need to change them, follow the procedure below to configure your serial port.

1. Click the Windows **Start** button.
2. In Windows 2000, 2003 and XP, select **Settings** and then **Printers**. In Windows Vista, select **Control Panel** and then **Printers**. The **Printers** folder will be displayed.
3. Click your right mouse button on the printer you wish to change your settings for and select the **Properties** option. The **Properties** dialog opens.

4. Click on the **Ports** tab.

5. To check your port settings, click on the **Configure Port** button. The **Port Settings** will be displayed.

6. Adjust your port settings as necessary and click **OK**.

7. Click **Close** to exit from the printer’s **Properties** dialog.

### Using the Correct Serial Cable

Because a printer and computer both use serial ports that have their inputs and outputs on the exact same pins, a wiring configuration must be established that crosses over the outputs from one port to the corresponding inputs of the other port. A serial cable that connects signals by crossing them over in this manner is referred to as a **null modem cable**. By contrast, a **straight-through serial cable**, often used to connect a computer to a modem, connects pins 1, 2, 3, etc. on the computer to pins 1, 2, 3, etc. on the modem. If a straight-through serial cable were attached to a printer, an output signal from the computer would go, not to an input pin of the printer where it can be received, but to an output pin of the printer where it would be ignored.

**Note:**

Some newer thermal printers do require a straight-through cable. If there is any doubt, you should consult the documentation provided by the manufacturer.

### Cabling and Flow Control (Handshaking)

It is also possible to cross over other lines so that the printer can offer the **hardware** handshaking option. (Refer to Serial Port Settings above.) Thus, it is important to consult your printer's manual to determine what cable is best. Some general purpose cable configurations, though they may contain more wires than all printers require, will work for a great variety of printers.
Note:
Refer to the help for your driver for pin and wiring diagrams of the null modem cables most commonly used by thermal printers, and for a special note on grounding.

Configuring for Performance

Performance Tips
Some of the graphics capabilities of Windows, including the ability to print TrueType fonts, can result in large amounts of information being sent to your thermal printer. Therefore, you should optimally configure your printer and personal computer.

The following tips contain information to help you maximize your printing speed and understand the difference between images that are formatted by Windows and images that are formatted by your printer.

Avoid RS-232 Serial Communication Whenever Possible
Some thermal printers come standard with only a 9-pin or 25-pin (RS-232) serial port. A parallel port, USB port, or Ethernet connection may be extra options. RS-232 serial communication will work fine if you only intend to use your printer's built-in bar codes and typefaces. However, if you want to take advantage of any of Windows' graphics capabilities, you will achieve significantly better performance if you use a parallel port, a USB port, or an Ethernet connection.

Use Printer-based Objects and Fonts or Downloaded Fonts Whenever Possible
Windows programs often print images, and non-downloadable fonts, by drawing them out dot-by-dot using bitmap graphics, a process that can slow the printer. Fortunately, many thermal printers can output bar codes, lines, boxes, and built-in (or downloaded) scalable text fonts using high-level
commands. A Windows program can, for example, print using a font built into the printer by outputting a few quick control codes, instead of sending a large dot-by-dot bitmap drawing of the text image.

There are times when a Windows program must output an image as a bitmap. So keep in mind, that the more graphics that you send to your printer, the slower your printing speed will be.

**Printer Capabilities That Are Not Available To All Programs**

Because most of the special capabilities built into thermal printers are different for each brand of printer, and because thermal printers are totally different from the more common printers used by Windows, it is just not possible for standard Windows programs to access certain high-level thermal printer commands. BarTender, however, was designed to take advantage of these commands.
Appendix A:  
Printer Driver Troubleshooting

This appendix presents the best procedure for solving printing problems.

Step-by-Step Procedure for Solving Printing Problems

If you are having any problems printing, take the following steps. If this does not resolve the problem, contact Seagull Technical Support (Refer to Appendix B: Technical Support.)

1. **Check Serial Port Settings:** If you are using a serial port, check your printer and Windows settings for baud rate, data bits, stop bits and parity. (Refer to Serial Port Settings in Activation.)

   Do not assume that the “default” printer settings shown in your manual reflect your printer’s actual settings. You must directly inspect either the mechanical switches (usually on the back of your printer) or the front panel menu settings before you can be sure how your printer’s communications settings are configured.

2. **Check Cable:** Check that the cable is properly connected and attached to the correct port on your computer, and that the Windows printer port settings accurately reflect the port to which the printer cable is attached.

3. **Print the Printer’s Status Page:** To check for mechanical problems with the printer, print out from the printer's control panel (not from a computer) some document or label that is built into the printer's memory. Such documents have different names depending on the printer model. They are sometimes called status pages, sample labels, configurations, or configuration labels. Consult your printer manual for the exact steps. If you are unable to print such a test document or label, you may need to have your printer serviced before you can continue with the rest of this troubleshooting process.
Note:
If you had to adjust a printer switch in order to output your printer’s status page, remember to put it back the way it was.

4. **Reboot Printer**: Your printer may not have properly reset after the last failed print job or after the last time you made a change to a communication setting. Turn the printer off and leave it off for five seconds before turning it on again. When it goes on again, make sure it completes its self-test procedure before you attempt to print again. (No lights should be blinking. Some printers will display the word **Ready** or display a ready light, usually green.)

5. **Print the Driver’s Test Label**: For the first print job after steps 1 through 4, use the Seagull printer driver's **Print Test Label** feature:
   a. Click the Windows **Start** button.
   b. Select **Settings** and then **Printers**. The **Printers** folder will be displayed.
   c. Click your right mouse button on the printer you wish to change your settings for and select the **Properties** option. The **Properties** dialog opens.
   d. Click the **General** tab.
   e. Click the **Print Test Page** button.
      If no label (not even a blank label) comes out and/or you get a printer communications error message, proceed to step 11.
      Otherwise, continue with step 6.

6. **Print Device Text From Application**: Create a label in your application. Use only the fonts built-into your printer, rather than Windows TrueType. If this test works, and you do not need to use any graphics or TrueType on your label, then you should be able to implement your desired label design right away and get back into production.

7. **Print Small Graphics From Application**: Add a very small graphic to the label, and one letter of TrueType text (such as Arial or Times New Roman). This first letter test should be a small size, around 12 pt.
   If the TrueType text and graphic do not print, you may need to upgrade the printer's firmware or memory. Consult your printer manual for more information.
8. **Print More Graphics From Application**: Increase the point size of your TrueType text and try printing an entire word or more in TrueType, instead of just a single letter. If this works, then you should go ahead and try to print all of the graphics you need on your label.

9. **Diagnose Printer Memory Shortage**: If all of your TrueType or bitmap graphics print perfectly only so far down the label and then are cut off cleanly straight across the label, you have insufficient memory in your printer to output the amount of graphics you are attempting to print. Contact your printer reseller for a printer memory upgrade.

   In contrast to the clean cut off described in the previous paragraph, if the printer outputs incorrect label data, corrupted graphic images, or even no label at all, this too may indicate a memory shortage. But, if you are using a serial port, it may also indicate a flow control (handshaking) problem, as described in step 10. (Always turn the printer off and on again following his type of failure.)

10. **Diagnose Serial Port Flow Control Problems**: If you are using a serial port and a print job stalls and/or generates a communication error message after some data has already been successfully transmitted to the printer, you may have a flow control problem.

    Test for this by slowing down your printing speed. For example, if you had been printing at 9600 baud, try a test print job at the much slower rate of 1200 or even lower. (Make the identical change in the port settings for both Windows and your printer.)

    If slowing down the baud rate made your problem go away, or caused the problem to occur later in the print job, then you should adjust your flow control settings. Try switching from **software** (**Xon/Xoff**) to **hardware** flow control (or vice versa). Be sure you are using a cable that will allow your printer to use **hardware** flow control. (Consult the printer's manual.)

11. **Diagnose Serial Port Cable Problems**: If the **Print Test Label** fails and you are using a serial port, you can test for a cabling problem by temporarily turning off flow control (handshaking).
   a. Verify that your printer’s communication settings agree with those in your Windows port settings.
b. Verify that you are using a “null-modem” cable, rather than a
“straight-through” serial cable.

c. Change the Windows Flow Control settings for your serial port to
**None**. Then, turn your printer off for five seconds and back on again.

d. After your printer has finished its power-on self-test, repeat the small
print job.

If the print job is successful, you have confirmed that the cable is
incompatible with the flow control (handshaking) system. Determine
what is wrong with your cable. Correct it, and then switch back to either
**software** (**Xon/Xoff**) or **hardware** flow control.

12. **Diagnose Other Problems:** If you still can’t print, it is very likely that:

- You have a second hardware product competing for an interrupt or
  I/O address with your communication port.

  or

- You have an advanced Windows setting configured improperly.

Either way, you need to contact your computer vendor or your
company's internal computer support staff for assistance.

Other possible problems:

- A bad (or improperly configured) serial printer cable. For example, a
  simple “3-wire” null-modem serial cable will not allow printing from
  inside Windows unless your flow control is set to **None**.

- The printer cable is attached to the wrong port of your computer.

- A malfunctioning printer port in your computer or printer.

- The printer is off or off-line.

- The computer’s communications port may be conflicting with some
  other hardware component in your computer.

You will have to rule them out one-by-one in order to solve your
problem.
Appendix B: Technical Support

If you still have questions after consulting this manual and the help system, Seagull’s Technical Support Department can be reached at the phone numbers and e-mail addresses below. Faxed technical support requests receive a faxed response. Internet technical support inquiries receive an Internet response.

Seagull Scientific, Inc. – USA, Canada & Latin America
Voice Telephone: 1 425 641 1408
FAX: 1 425 641 1599
Internet: TechSupport@SeagullScientific.com

Seagull Scientific Europe, Inc. – Europe, Middle East & Africa
Voice Telephone: +34 91 435 55 45
FAX: +34 91 578 05 06
Internet: EuroTech@SeagullScientific.com

Seagull Scientific Asia-Pacific, Inc.
Voice Telephone: +886 2 3765 2440
FAX: +886 2 3765 2467
Internet: AsiaTech@SeagullScientific.com

Seagull Scientific: Japan Branch Office
Voice Telephone: +81 3 5847 5780
FAX: +81 3 5847 5781
Internet: JapanTech@SeagullScientific.com

Note:
Technical support for Visual Basic Scripting is limited. For information on support limitations, please refer to Technical Support, A Note on Technical Support for Visual Basic Scripting in BarTender’s help.
You **Must** Register Your Software to Receive Support

Register your product online at:


*Unless you register your product, you will not receive technical support.*

**You Must Call From Next to Your Computer**

When calling for technical support, it is very important to call from a phone right next to a computer that is running BarTender. This makes it much easier for our technical support personnel to assist you.
Index

A
Access, 12
activation, 1, 3, 4
Activation Wizard, 3
Add Database Connection Wizard, 12
administration
  Web Print Server, 22
asking for help, 15

B
bar code
  changing symbology of, 13
  changing the size of, 9
  creating, 8
  moving, 9

C
clipboard, 9
Commander program, 1
  common procedures, 18
contacting Seagull Scientific. See Seagull Scientific, contacting
copy
  label object, 9
creating a new format, 6
creating objects
  importing pictures, 13

D
Data Source Wizard, 10
database
  reading data from, 10, 12
  setting up a connection to, 12
date
  as label data, 10
deleting an object, 10
demonstration mode, 2
dialog
  Database Connection Setup, 14
  Modify Selected Bar Code, 13
  Modify Selected Object, 13
  Modify Selected Picture, 14
  Page Setup, 6
  Print, 6, 14
  query prompts, Web Print Server, 22
dialog (Commander)
  Task Options, 18
downloadable fonts, 28
driver installation
  Seagull Driver Wizard, 23
driver removal, 24
driver upgrades, 24

E
editions
  of BarTender. See Enterprise Editions.
Enterprise Editions, 2, 3
Enterprise Print Server edition., 1, 4, 21
erasing an object, 10
Ethernet connection
  better than RS-232, 24, 28
Excel, 12

F
flow control
  of serial ports, 27, 33
format
  label. See label formats.
G
graphics
importing, 13

H
handles, 8
handshaking
of serial ports, 27, 33
HASP, 2
height
changing bar code, 9
changing text object, 9
of labels, 7
help
about Seagull License Server, 3
help system
asking for help, 15

I
Identical Copies of Label option, 14
importing pictures, 13
installation
of BarTender, 4
of Seagull License Server, 3
of Seagull's Windows printer drivers, 23
of the security key, 2
of Web Print Server, 4
Internet address for Seagull Scientific, 35
interrupt or I/O address conflict, 34

L
label formats
creating, 6
preexisting, 14
pre-made, 14
search function, Web Print Server, 21
supplied by Seagull Scientific, 14
label size
specifying, 6
label stock, 6
labels
printing, 14
license. See Seagull License Server.

M
margins
page, 7
Microsoft Access, 12
Microsoft Excel, 12
Microsoft SQL Server, 12
moving an object, 9

N
New Format Wizard, 6
null modem cable, 27, 34

O
ODBC
reading data from, 10, 12
OLE DB, 10, 12
Oracle, 12
orientation, 7

P
parallel port
better than RS-232, 24, 28
paste
label object, 9
PDF printing, 21
pictures
importing, 13
position
changing an object's, 9
predesigned label formats, 14
preexisting label formats, 14
printer
    specifying, 6
printer-based objects and fonts, 28
printing
    a test label, 31, 32
    performance tips, 28
    troubleshooting, 31
printing labels, 14
properties
    of label objects, 13

R
reading label data from a database, 10, 12
registering BarTender, 36
removing an object, 10
RFID, 1
RFID object
    creating, 8
RS-232 serial port, 24, 28

S
SAP
    reading data from, 10, 12
screen. See dialog.
screen data, 10
Seagull License Server, 1
    installation, 3
Seagull Scientific
    contacting, 35
search
    label formats, Web Print Server, 21
security key, 1, 2
selecting
    objects, 8
serial cables, 27
serial communications, 24
serial port
    parameters, 25
serial port parameters
    of printer, 26
    of Windows, 26
site administration
    Web Print Server, 22
size
    of labels. See label size.
    paper, 7
smart labels. See RFID.
SQL server, 12
stock, 6
straight-through serial cable, 27, 34
support, technical, 35
Symbology, 13

T
task list
    creating/modifying in Commander, 18
    running, 19
tasks on task list
    deleting, moving, and reordering, 18
    technical support, 35
telephone numbers for Seagull
    Scientific, 35
text object
    changing the height of, 9
    creating, 8
time
    as label data, 10
toolbox, 15

U
USB port, 2, 3
    better than RS-232, 24, 28

V
Visual Basic, 10, 16
W

Web Print Server, 1, 4, 21, 22
width
  of labels, 7
window. See dialog.
Windows service
  Seagull License Server can be run as,
    16